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This document is available for download at http://etaluma.com/products/downloads. Any steps specific for a
particular LS model are noted in italics.

. Setting Up the LS Microscope

A. Items Included With Each LS Microscope

1. LS720

USB communication cable

External power supply/cord with country-specific plug
Hex wrench (3 mm) for removing/replacing shipping lock
Fluorescence shroud

Calibration 1536 well microplate

Calibration 4x objective

2. LS620 and LS600

Brightfield Illuminator LS620/LS560/LS460

USB power/communication cable

Fluorescence shroud

External power supply/cord with country-specific plug LS620/LS560

3. LS560 and LS460

Brightfield Illuminator LS620/LS560/LS460

USB power/communication cable

Fluorescence shroud (LS560 only)

External power supply/cord with country-specific plug LS620/LS560 (LS560 only)

B. Optional Accessories (purchased separately)

®  Phase Contrast Accessory L5720 (Olympus)

® Phase Contrast Accessory L5620/LS560/LS460 (Olympus)
e Manual XY Stage LS620/LS560/LS460

e Labware Holders

Holder for 35 mm Petri dishes, fits inside Holder for 60 mm Petri dishes
Holder for 60 mm Petri dishes & Terasaki plates, SBS outer dimensions
Holder for microscope slides & 50 mm Petri dishes, SBS outer dimensions
Holder for 4 microscope slides in parallel, SBS outer dimensions

e light Hood
e Lumaquant, image analysis software
e  Microvolution, deconvolution software

C. Recommended Computer Specifications

All LS Microscopes: Windows 7, 8, 8.1, or 10; Core i5 or better processor; 500 GB to 1 TB hard drive, 4 GB
minimum RAM; single 4K monitor or two with 1080p HD resolution. Windows must have Service Pack 2.0
with .NET version 4.5.2.
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LS720 only: Due to autofocus, Z-stacking, and tiling, a solid-state hard drive (SSD) is required.

Microvolution deconvolution software: A GPU is required; the most powerful NVidia chip running CUDA
that can be afforded is recommended for best performance.

D. Placing the LS Microscope

1. Remove LS Microscope from the shipping box (save box and packing materials) and place on a sturdy
bench or counter.

2. If the LS Microscope will be used in an incubator or environmental chamber, it is recommended that
the initial setup be carried out in a room with ambient conditions before placement into the
specialized environment. See Section 1.0. for information about live cell imaging in a specialized
environment.

E. Removing the Shipping Lock (LS720 only)

WARNING: You must remove red shipping lock before plugging the LS720 into
power! If not removed, the LS720 will be damaged! (See Appendix A for full
details.)

1. Using the supplied 3 mm hex wrench, loosen the 2 set screws on top of the
installed shipping lock. Loosen the 2 set screws (smaller and more internal) on
bottom of the lock.

2. Unscrew completely the 2 larger 1-inch screws on bottom of the shipping lock. LS720 Shipping lock
Slide the shipping lock toward you to remove.

3. Keep the 4 set screws screwed into the shipping lock and place in a secure place along with the two 1-
inch screws and 3 mm hex wrench.

WARNING: [f packing the LS720 for shipment, you must install the red shipping lock before placing into
the shipping carton! If not installed, the LS720 can be damaged! See Appendix A for instructions.

F. Connecting the Cables

1. Wait to connect the USB cable from the LS Microscope to the computer until Lumaview is installed
(see Sections I.M-N. below).

2. (LS720 Only). Plug the external power supply/cord into the left side port (when viewing from the
front) and the plug into an AC outlet.

G. LED Power

1. (LS720 only). The external power supply/cord also supplements power coming from the computer via
the USB cable to power the LEDs at a higher level than if connected by the USB cable only.
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(LS620 and LS560 only). For almost all fluorescence imaging applications, power from the computer
via the USB cable to the LS Microscope will be sufficient. If higher levels of illumination are required,
e.g., with very dim samples, insert the small round plug of the external power supply/cord into the
round port labeled SUPPLEMENTAL POWER on the back of the LS Microscope and the electrical plug
into an AC outlet. You should see a moderate increase in the Illumination level.

H. Phase Contrast

1.

LS720 only

If using the Phase Contrast Accessory L5720 (Phase
Accessory), remove from its shipping box (save box
and packing materials). Attach Phase Accessory by
placing the holes on the bottom of the Phase
Accessory arm over the pegs on the upper surface
(right rear) of the LS720. Make sure pegs are fully
seated and arm is totally flush with the LS720
surface. Tighten the large thumb screw at the back
of the Phase Accessory arm.

Phase Accessory arm Phase Accessory cable
attachment

Connect the free end of the Phase Accessory communication cable to the round port on the LS720
back panel (left side) labeled External Lamp Power Out. This allows the Phase Accessory to be
controlled by Lumaview.

2. (LS620, LS560, LS460 only)

If using the Phase Contrast Accessory LS620/560/460 (Phase Accessory),
remove from its shipping box (save box and packing materials). Ensure that
the Phase Accessory adaptor is attached to the rear tab of the LS
Microscope Deck. Attach Phase Accessory by inserting the base of the arm
into the Phase Accessory adaptor. Ensure it is fully seated and tighten the
thumb screw on the bottom of the adaptor.

Phase Accessory adapter

Connect the free end of the Phase Accessory communication cable to the
round port on the LS Microscope back panel (left side) labeled External Lamp
Power Out. This allows the Phase Accessory to be controlled by Lumaview.

3. Insert the phase contrast Slider (pre-centered version included with Phase
Accessory) into the slot going through the condenser. Of the 3 positions in the
Slider, the phase ring is visible and typically present in the middle position. Any
open positions can be used for Brightfield.
I. Brightfield Inserting Slider
1. For optimal brightfield, use of the Phase Accessory (Section |.H. above) with the included Slider in an

open position (no phase ring) is recommended. The Phase Accessory, which provides collimated light,
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is directly connected to the LS Microscope, allowing it to be controlled by Lumaview. It should also be
used when imaging in a dark environment such as an incubator. To mount the Phase Accessory on an
LS Microscope, see Sections I.H. above. Brightfield images will be in gray scale due to the
monochromatic CMOS camera.

If the Phase Contrast Accessory is not available, ambient light in a typically lit area can often be used.
The light should be as uniform as possible to prevent shadows or other dark or light areas. Overhead
fluorescent lighting can cause uneven brightness including a striped pattern on the image; if observed,
move the LS Microscope or partially shade the light to reduce unevenness across the sample.

J. Installing Objectives

LS720 only

a. Unscrew the deck knob at the front of the instrument (side with LS720 logo)
and raise the top deck (the top layer of the hinged 2-layer deck). Tipping the
top deck backward will latch it into place. Unscrew the black cap (or
previously installed objective) on top of the optics block and screw in the
objective. Do not overtighten. To lower the top deck, activate the release
lever, lower the deck, and tighten the white deck knob.

LS620, LS560, LS460 only Deck release lever

a. Manually remove the insert of the top accessible deck. Unscrew the black cap (or previously
installed objective) on top of the inside optics block and screw in the new objective. Do not
overtighten. Return the removable insert to the deck.

When installing or changing an objective, carry out the insertion quickly to minimize dust falling onto
the mirrored dichroic filter. A small amount of dust will not affect imaging. However if dust is
significant and it appears to affect quality of the live image or snapped images, contact Etaluma by
email (support@etaluma.com) or telephone (760-298-2355) to discuss possible methods for cleaning.
IMPORTANT: Using compressed air can result in an oily liquid being sprayed onto the dichroic, which
may damage it. Similarly use of physical methods such as swabs or lens paper may also damage the
dichroic and must NOT be used.

K. About Lumaview

1.

LS Microscopes LS720, LS620, LS600, LS560, and LS460 are controlled by the Lumaview software
program. The latest Lumaview version is downloadable from Etaluma’s website and must be installed
prior to connecting your computer for the first time to the LS Microscope (due to the need for two
drivers that are installed on the computer at the same time).

Lumaview will run on Windows 7, 8, 8.1, and 10. Both desktop computers and laptops can be used,
but the best visualization correlates with monitor resolution equal to the sensor resolution (up to 1900
x 1900 pixels). Note: The monitor does not affect image resolution unless the monitor is low quality
and affects your ability to judge focus.

The computer should have Windows .NET Framework 4.5.2 or higher installed; see
https://msdn.microsoft.com/en-us/library/bb822049%28v=vs.110%29.aspx for more information. If
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your computer does not have .NET Framework 4.5.2 or higher installed, downloading Lumaview may
automatically take you to the Microsoft .NET download page. Scroll down the page to find the correct
download. This should not require a purchase. Contact Etaluma with any questions.

L. Downloading and Installing Lumaview

1. To download Lumaview, go to http://etaluma.com/products/downloads (under the Resources tab).
Click on Lumaview - ZIP link to start the download and save the folder when prompted. Go to your
downloads location and click to open the Lumaview_v(version#).zip file.

Alternatively, the same Lumaview_v(version#).zip file can be copied from the flash drive that comes
with the LS Microscope. Verify that this file is the latest version as posted on the Etaluma website.

2. Lumaview will not run on a computer with Lumaview 500/400 installed. To uninstall, use the
procedure described in Appendix B.

If your computer has an older version of Lumaview or Lumaview 720/600-Series (latter no longer
used), installing the newest Lumaview will overwrite the older versions.

If there is a need to revert to an older version Lumaview, it will be necessary to first uninstall the
current version using the procedure described in Appendix B.

3. Toinstall Lumaview, right click on the .zip file and Open with Windows Explorer. Double click on the
.msi installer file to start the installation. If a Windows warning box about an unrecognized App
appears, click Run anyway.

You will be asked about the location; note that the default is a new Etaluma folder inside the Program
Files (x86) folder. During installation, a Device Driver Installation Wizard will open. Click to continue
(twice) and finish installing the two drivers. Installation of Lumaview will then finish. After installation,
a Lumaview shortcut (orange circle icon) convenient for launching the software will be present on the
desktop.

M. Connecting the LS Microscope

1. If connecting with a computer that has been off, turn computer on. Make sure computer is connected
to its monitor(s). Insert the standard USB-A end of the supplied USB cable into a USB port on your
computer and the other square USB-B end into the square port on the L5720 left side or the square
port labeled TO COMPUTER on the back of the L5620, LS560 and LS460. The same USB port on your
computer should be used every time you connect to the LS Microscope. It is also important to connect
the LS Microscope directly to the computer USB port and not use a USB hub.

2. If Lumaview has not been run previously, it is important that the LS Microscope and computer be
connected using the USB cable before launching Lumaview. This is because Windows needs to load
the USB drivers before Lumaview can run. After the first time, the program can be launched before
connecting the LS Microscope and computer. In the latter case, only the Outer Main Window will
open (see Section II.B. below). Connecting the LS Microscope and computer with the USB cable will
result in opening of the Live Image Window as well.

N. Live Cell Imaging with LS Microscope in an Incubator
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1. Prior to imaging in an incubator, place the LS Microscope inside for at least 6 hr and preferably
overnight to allow thermal equilibration. Before transferring to the incubator, disinfect the LS
Microscope using any of the suggested procedures in Appendix C. Condensation on the microscope,
including on the objective, will form in the first minutes but will evaporate as thermal equilibrium is
achieved. Focus levels may change during this equilibration as materials expand.

2. Pass the communication and optional power cable through the incubator port, which is often located
in the upper back wall. A plug or filtered stopper may be present. Every LS Microscope now comes
with a foam plug that can be used to seal around the cable(s) going through the port. Or the existing
plug can be adapted as well. Make sure there is enough slack in the cables inside the incubator for
sliding out the shelf. Place the computer to be used on a flat and stable surface near to the incubator
and within the 3 M USB cable provided.

WARNING: Do not extend the USB cable or use another USB cable other than that supplied,
particularly a longer one, as communication issues will arise.

3. LS620, LS560 and LS460: Place the sample on the microscope, adjust focus and close the incubator
door. Check the focus after 60 min to confirm it is still good. If the focus has changed, refocus and
repeat. For higher magnification objectives (40x and above), a focus drop of a few microns may occur,
which can be compensated for by over focusing to a height above the focal plane equal to the
expected drop. In this case, the focus will drop to the correct level within a few minutes.

4. LS720 only: Place the sample in the labware carrier and ensure it is seated flat with the upper left
corner firmly pushed into the frame. Close the incubator and return to Lumaview to focus. The
motorized Z axis will maintain focus level and autofocus can be used to adjust any change in focus over

time.

5. The system is now ready for live cell imaging.
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Il. Software: Getting Started with Lumaview

The following sections give instructions for getting started with Lumaview on the LS720, LS620, LS560 and
LS460 and are intended as a Startup Manual only. Not all options are given and not all features may be
explained in any particular section. The complete User Guide for Lumaview is contained in the Help Section
after Lumaview is opened. Click on Help in the Title Bar to open the pulldown menu and click Contents, or
simply Click F1 to open the Help Section. Becoming familiar with the complete Help Section is a must for
using LS Microscopes optimally and taking advantage of the many features of these Microscopes and
accompanying software.

A. Starting Conditions

Lumaview has been downloaded and installed on the computer.

The LS Microscope is connected to the computer via the UBS cable.

LS620, LS560, or LS460: Sample to be imaged is present on the LS Microscope stage.

LS620 or LS560: Fluorescence shroud is over sample if imaging involves fluorescence.

LS720: Red shipping lock MUST be off, power cable is plugged into a standard AC outlet, and fluorescence
shroud is available if imaging involves fluorescence.

vk wn e

B. Launching Lumaview

1. Launch the Lumaview software from the desktop icon (or other chosen location) and allow the LS
Microscope to be discovered. This may take a minute or so the first time. Two windows will open on
your monitor:

a. Live Image Window inside the larger Main Window. “Live Image Window” will be in the title bar
when the Window is not maximized. When Live Image Window is maximized, [Live Image
Window] transfers to the end of the Main Window title bar.

The Live Image Window status bar at the bottom shows communication with the camera sensor
via continuous display of several useful metrics: current frame rate, data transfer rate, number of
frames collected thus far in the session, frame size, and session date and time start.

b. Main Window with Lumaview v(version number) in the title bar. When Live Image Window is
maximized, the title bar becomes Lumaview v(version number) — [Live Image Window].

Note: If Live Image Window is not present, there is likely a Driver issue. Follow procedure on
Driver Resolution in Appendix D.

2. The Live Image Window includes a Left Toolbar with the maximum following commands:

Manual Image

Manual XYZ (L5720 only)

Snap Image

Composite (LS720 and LS620 only)
Video Record (toggles on and off)
Protocol

™ 0 oo T o

Zoom

Ul B EEEElE
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h. Last File

When Lumaview is open, the icon that resides in your computer dock appears as a document with an
arrow.

C. Initialization and Calibration (LS720 only)

1. The LS720 automatically initializes every time Lumaview is started by moving the microplate carrier to
the Home position. The Home Position consists of the left front corner of the microplate carrier frame
being positioned over the objective and the objective retracted to the lowest Z level. No image can be
obtained at the Home position because it is under the microplate carrier frame.

2. [If this is the first time the LS720 has been connected to the current computer, it is first necessary to do
a Calibration. Once completed, calibration is not needed unless a different computer

is connected or the XY position appears to be different from the expected position, ﬁ f‘ﬁ
e.g., center of microplate wells. X Mo o)

& sepsice

X [7885

¥: [703 ﬂJﬂ o0
v

a. To calibrate the LS720, install the provided Calibration Motic EFN 4x Objective.

Focus (um)

Place the provided Calibration 1536 well microplate into the microplate carrier. . EEr ﬂ
b. Click Utilities in the File Menu bar and in the drop-down menu click Calibrate to
open its dialog box. A communication dialog box will open asking if a 4x objective
has been installed. Click Yes and the communication dialog box will close. N
[t |
c. The Live Image Window will now show red crosshairs, and the microplate carrier
will move so well Al is close to being over the objective. [ |

d. Click the Manual Image icon in the left tool bar (top icon) to open its dialog box.

e. To use ambient light for calibration (recommended; see Section I.1.), check
Brightfield in Manual Image to activate Gain and Exposure sliders. Start with
Gain as low as possible and adjust Exposure until a mid-gray tone is shown in
the Live Image Window. Red crosshairs in Live

Image Window

f. If using the Phase Contrast Accessory for brightfield illumination (Section I.1.),
move the phase slider to an open position (without phase ring) and move the phase condenser
aperture (small lever on condenser front above slider) so only a low level of light
is transmitted. In Manual Image, check Brightfield, set Gain to minimum,
lllumination (%) to minimum, and adjust Exposure until a mid-gray tone is seenin | "™
Live Image Window. S

X

Manual Image ?

I Brightficld

|

|
i

=

I™ Blue
IHlumination (%) —
Gain

g. In Calibration, move the Focus slider up while watching the Live Image Window Femn(r)
to detect when the well outline can be seen and is in sharp focus. The Focus o
slider area becomes green whenever the Focus slider is active. Using the X/Y =
Move arrows (and Step size arrows if needed), move the microplate carrier until o
the Al well is centered in the Live Image Window. Make sure the centered well

i

|

I

i

<]
&

LS Microscope Startup Manual 2018.7.25



D.

Instrument Setup

1.

h. In Calibration, click Accept Calibration. The Calibration

i. Test the calibration on other wells by clicking the promers ] piow 3 e
Select Labware button in Manual XYZ to opens its T =
dialog box. (If Manual XYZ is not already open, click its | N ltmk :
icon in the left tool bar (second from top). g @ o |

j.  Click on Generic1536WellMicroplate.elf to highlight it o Tl S
and then click OK. The appropriate Labware Map ’
dialog box (1536 well in this case) will open. Click on —

is A1 by moving to the left and up using the X/Y Move arrows, and then re-center the A1 well.

. . . Manual XYZ [ =
dialog box will now convert to the Manual XYZ dialog e
b OoX. e StopAll Axes
x oo
Y: oooo AI

=
4| > Labware Details:
I Reverse X . Stepsize:

any well and the microplate carrier will move to center

that well over the objective. Test the microplate U
corners and other wells distant from each other. If any

wells are not centered, repeat the Calibration procedure described above
in this Section.

Instrument Setup ?

 Ls460 & L5560 € Ls0600  © LS720

Click on Configuration in the File Menu bar to open the drop-down | e [ i [

menu and select Instrument Setup to open its dialog box. By S
F =
LEDPreSnap(sec) | 10 =] [~ AutoCompositt | Individusl Channel Folders (only for protoccl)
Check the Lumaview version to make sure it is the most recently -
. . v [V Display scale bar Select Color
posted version on the Etaluma website e
(www.etaluma.com/products/downloads/). Ensure that the LS " e

Microscope being used is checked. If it is necessary to change the
LS Microscope model number that is checked, you will be L=
prompted to restart the program. Be sure to restart so that all

functions work correctly.
Click the Objective button to open its dialog box (called Objective
Lens Selection). Select the desired objective to highlight it. Note
that other fields about the objective and image automatically fill
based on magnification and a frame size of 1200 x 1200 pixels (LS720
and LS620) or 1200 x 1200 pixels (LS560 and LS460). Click OK. Once selected, the same information
automatically fills in Instrument Setup.
Click the Frame Size button to open its dialog box. Using the pull-down menu, e s 5150
select frame size desired (frame size will be the number times itself because it is R
square). While the maximum is 1900 x 1900 pixels, the default is set to 1600 x =1
1600 pixels for LS720 and LS620, and 1200 x 1200 pixels for LS560 and LS460.
Note: If larger Frame Sizes are used, there will be some darkening in the corners. If faster frame rates
are needed, use smaller frame sizes, e.g., 800 x 800 pixels.)
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If the Frame Size is changed, there will be a prompt to restart
Lumaview. Click OK to close the prompt and then shut down
Lumaview. Upon restarting Lumaview, the frame size in the lower
status bar will be the new size. If not restarted, the new frame size

may show in Instrument Setup but it may not actually be different. Always check the lower left status
bar of Live Image Window to see the actual frame size.

In erder to change the frame size you must shut down and restart Lumaview.

Continue to review and adjust the various settings in Instrument Setup. For Root, enter desired file
name root for all images in this imaging session. Select the file format desired (Tiff is recommended).

The Time-lapse folder path default is given but can be changed if desired. Time-lapse is set up under
Protocol as described in Section II.K. below. Note that the folder name Lumaview720 is the current
default name and is used for images snapped on the other LS Microscopes as well unless a different
folder is chosen.

Select the time in seconds for each LED to be on before image snap. Recommended time for
fluorescence is 0.6 seconds (do not go below this time). Check Auto Composite (LS720 and LS620 only)
to have images in multiple channels automatically composited and saved in the Composites folder.
Check Individual Channel Folders to have images from multiple channels in a Protocol saved in
separate folders (e.g., for compiling time-lapse videos in single channels).

Of the next 6 features listed on the left, check those desired:

a. Time/date label will be displayed in the lower left corner of each image.

b. Hot pixel removal. Check if desired and then complete Instrument Setup. (To start this feature,
click Utilities in the title bar and from the pull-down menu select Detect Hot Pixels to open its

dialog box. Information on next steps is available in the Help section.)

c. Pseudo color FL channels (all LS Microscopes except LS460) results in live and snapped fluorescent
images colored with the channel color and according to signal intensity.

d. “Click” sound for manual image snap results in a “camera shutter-like” sound whenever a manual
image is snapped.

e. Manual image autosave results in images being saved
automatically without the Save As dialog box opening each time.
When checked, each image is numbered according to R oo
DOYHHMMSSmm where DOY is day of year, HH is hour in 24 ey
hour time, MM is minutes, SS is seconds, and mm is milliseconds.
Thus each image number is unique and in numerical order.

Not checking Manual image autosave will result in the Save As e
dialog box opening every time the camera icon is clicked and the | . ...
image has been snapped. In this case, the image file name

desired must be entered before clicking Save.

12
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E.

9. On the right side of Instrument Setup, checking Display scale bar results in a scale bar in the lower right

corner of live and snapped images. If checked, click Select Color to choose color, check
objective power if desired, and select Scale bar width.

Display

10. After all settings have been selected, be sure to click OK to save the settings before exiting

Instrument Setup.

Finding a Live Image for Manual Focus

1.

Install the desired objective and sample labware. LS620, LS560, and LS460 only:
Manual XY movement of SBS labware (microplate footprint) is facilitated by
Etaluma’s Manual XY Stage (optional). For labware that is not SBS, use a labware
holder such as the Multi-Slide Holder for 1-4 microplate slides. Update Objective in
Instrument Setup as needed (Section II.D above) and click OK.

Click on the Manual Image icon in the Left Toolbar (top icon) to open its dialog box.
LS560 dialog box contains only the Green and Brightfield controls; L5460 dialog box
contains only the Brightfield controls. LS720 only: Click the Manual XYZ icon in the
Left Toolbar (second icon from top) to open its dialog box; Manual Image and Manual
XYZ are used together to find and focus on samples in the labware. If desired, move
dialog boxes to the sides of the Live Image Window. If closed and then reopened,
they will open in the same locations prior to closing. However, when Lumaview is
closed, the dialog box positions will not be saved.

Manual Image

¥ Brightfield

lllumination (%) — )7
ain -

X

zmﬂ

Y- {0.000 AI
. !I 01000

Stop All Axes

Stepsize:

4.996 El:

LS720 only: Select a desired XY location in a sample labware using one of two options huocs ——
. [— 1
in Manual XYZ: ﬂ -
a. Use the X/Y Move arrows (and Step size arrows if needed) to move to different _seettomers | Lot
locations or wells in the sample labware, or
s
b. Click on Select Labware to open its dialog box. Click on the labware type
desired to highlight it and click OK. The appropriate Labware Map will )
then open. Click on a location and the microplate carrier will move so the
location is centered over the objective. For further movement from the
location, use the X/Y Move arrows (and Step size arrows if needed) in —
Manual XYZ. Clicking again on the original location in Labware Map will re- =
center on that location.
oK
c. Image orientation: The live image displayed on the monitor is as viewed
from the bottom as for all inverted microscopes. To see the live image as == e
viewed from the top, check Horz. Flip image in Manual XYZ. However, all s mmm—————
images are captured as viewed from the bottom. FOSCIEnEEnERE

d. XY movement: In Manual XYZ, when a directional arrow in XY Move is clicked,
the live image on the monitor moves in that direction. However, the labware
moves in the opposite direction in order to place the new location over the

(| 0 5 0 ) . o

BIEEEEEEEEIEEEE
[ EEEEEEEEEEEE
[ 5 0 o o o
EEEEEEEEEEEE
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objective. For example, to image a location to the right of the current location, the labware must
move to the left for the new location to be over the objective. To have the live image and labware

move in the same direction, check either or both Reverse X dir. And Reverse Y dir. This feature is

particularly helpful when moving across labware, e.g., going well to well in a microplate.

4. In Manual Image, select the channel(s) to use. For fluorescence, the included Shroud (or other
protection from light) must be placed over the labware. Start with Exposure at maximum and Gain as
low as possible. Increase Illlumination gradually to the desired brightness. For dim samples, if
Illumination is at maximum, increasing the Gain can be used to increase signal but it will also increase
the background. LS620 and LS560: Illumination can also be increased by using the external power

supply/cord (See Section |.G.).

5. For brightfield using ambient light, start with Gain as low as possible and adjust Exposure until a mid-

gray tone is seen in the Live Image Window.

For brightfield using the Phase Contrast Accessory (use open position in Slider, see Section I.1.), check

Brightfield in Manual Image and turn phase condenser iris (on front of condenser) so only a low level

of light is transmitted. Set Gain to minimum, lllumination (%) to minimum, and adjust Exposure until a

mid-gray tone is seen in Live Image Window.

6. For phase contrast using the Phase Contrast Accessory (use appropriate Slider phase ring for objective,
Section I.H.), check Brightfield in Manual Image and turn the phase condenser iris (on front of
condenser) to the left to the fully open position. Turn Exposure and Gain to very low. Increase

Ilumination (%) until a mid-gray tone is seen in the Live Image Window.
F. Manual Focusing
1. LS720 only:

a. In Manual XYZ, move the Focus slider up while watching the Live Image Window to
detect the sample coming into focus. The Focus slider area becomes green
whenever the Focus slider is active. Clicking on the slider vertical line above or
below the current focus level causes the focus level to jump up or down,
respectively, by 100 um. Continue to adjust the focus using the Focus Z up and
down arrows (and Step size arrows if needed) until a sharp image is achieved.
Adjust [llumination and Gain settings in Manual Image during the focus process as
needed. Click the Set Bookmark button to record the focus level for easier return
to this level.

b. To facilitate the focusing process, click on the Zoom icon on the Left Tool Bar (fifth
from top). The Zoom feature toggles between displaying the entire image fitted to
the Live Image Window and displaying the image matched 1:1 with the monitor
resolution (pixel: pixel). If the monitor resolution in pixels is less than the frame

e ()
x: 5000 _A_J

Select Labware | Location:

Create Z-Map
Edit Z-Mop

size, which is typical, the image will be enlarged (zoomed). The Live Image Window will now show

a center portion of the entire image. Click the Zoom icon again to fit the image to the Live Image

Window.

LS Microscope Startup Manual 2018.7.25
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2.

LS620, L5560, LS460 only

a. Unless approximate sample focus level is known, it is best to initially raise objective to maximum
height (without hitting sample) and then turn focus knob counter-clockwise until sample comes
into focus. Ensure you are focusing on correct sample plane and not another surface, for example,
back side of a microscope slide. If uncertain, place a similar but easy to focus sample on stage,

focus, and then switch to new sample.

b. To facilitate the focusing process, click on the Zoom icon on the Left Tool Bar (fifth from top). The
Zoom feature toggles between displaying the entire image fitted to the Live Image Window and
displaying the image matched 1:1 with the monitor resolution (pixel: pixel). If the monitor
resolution in pixels is less than the frame size, the image will be enlarged (zoomed). The Live
Image Window will now show a center portion of the entire image. Click the Zoom icon again to fit

the image to the Live Image Window.

c. If necessary, adjust lllumination and/or Gain as needed.

G. Snapping Images

H. Auto-Generation of Single Composite Images

1.

LS Microscope Startup Manual 2018.7.25

When the desired field has been illuminated and focused in Live Image Window (Section II.F. above),
click the Camera icon in the Left Tool Bar (third from the top) to snap the image. If the Zoom function
was used to focus, the image captured will include the entire field of view (FOV) observable with the
Zoom off. If “Click” sound for manual image snap was checked in Instrument Setup (Section 11.D.), a

shutter-like sound occurs when each image is snapped.

If Manual image autosave was checked in Instrument Setup, images will be saved automatically using
the time-based numbering system (Section 11.D.8.e.). If Manual image autosave was not checked, a
Save As dialog box will open after the image was snapped. Images will be saved in the Etaluma folder
formed automatically whenever Lumaview is downloaded and installed. See Appendix E for the

automatic subfolder directory that appears within the Etaluma folder.

Images are captured and saved as seen by the camera, i.e., from the bottom. LS720 only: If desired,
images can be flipped horizontally to show how they would appear from the top. To accomplish this,
check “Horz flip image” in the Manual XYZ dialog box. The message “The image is flipped horizontally
and so appears as if viewed from above” is then displayed at the top of the dialog box.

To view the last image snapped, click the Folder icon in the Left Tool Bar (bottom icon) to launch

Windows Explorer and open the most recently used Destination Folder.

Fluorescence composites (LS720 and LS620 only)

a. InInstrument Setup (Section 11.D.), make sure Auto Composite is

checked.

Composite Color ?

Channels lllumination %  Gain Exposure (ms)

[V Blue

20 B 53 B [ms H

e [02 B 525 H 38 B

[V Red

[0 B [53 EH [ms

OK Cancel

X
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2.

b. Click the Composite icon in the Left Tool Bar (fourth from the top) to open its dialog box. Check the
channels desired. To use values optimized previously in Manual Image (Section II.E-F. above), click
Use Manual Settings to upload the settings. Values can also be entered manually.

c. Click OK to start the snapping of individual images in progression. Each LED will turn on for the
pre-snap interval and then flash when the image is snapped. If “Click” sound for manual image
snap was checked in Instrument Setup, the shutter-like sound will be heard for each image.

d. The fluorescence composite image will appear automatically in the Main Window matched 1:1
with the monitor resolution (pixel:pixel) and with its Title Bar showing the full path where it is
located.

Composites including phase contrast or brightfield (LS720, LS620, LS560)

a. InInstrument Setup, make sure Auto Composite is checked.

b. Configure a Protocol with the channels desired (See Section II.K. below). In the Acquisition tab,
select Time-Lapse and set both Interval and Duration to 1 sec. Click Run and after the images are

snapped, click the Last File icon in the Left Tool Bar (lowest icon). The folder containing the
individual images plus the Composite image will open.

I. Live Video (Manual)

When a desired field has been illuminated and focused in Live Image Window, click the Video Record
icon in the Left Tool Bar (fifth from the top) to open its dialog box. Select parameters requested and
also those in Instrument Setup such as file format (Section 11.D.). Images captured will be saved to the
Video folder inside the Manual folder shown in Appendix E.

Click OK and image capture will begin. To stop image capture, click the Record Video icon in the Left
Tool Bar again.

J. Videos from Time-Lapse and Live Video

Several options are available for compiling videos from sets of time-lapse (see Section II.L.) and live video

images:

1.

Lumagquant software offered by Etaluma (see Lumaquant Startup Guide for compiling images into
video). The Lumaquant Startup Guide can be downloaded from Etaluma’s website
(www.etaluma.com/products/downloads/).

Other video compiling software such as ImageJ, Fiji, MSMoviemaker, iMovie.
Two freeware software programs used together, i.e., AviSynth and MeGUI (instructions described in

Appendix F). If using this option, be sure to read the instructions first because the two programs must
be downloaded before image capture.

16
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K. Setting Up Autofocus (LS720 only) on

if viewed from al

s flipped horizontally and so
bove.

1. Use Manual Image and Manual XYZ to find a focused live image in a desired XY . Bl
position as described in Section II.F. above. In Manual XYZ, click the Autofocus Setup | @ ﬂﬂﬂ
button to open its dialog box. e W] oo 3

2. Transfer the manually determined Focus Z level in Manual XYZ to the Center position

field of Autofocus Setup. The Focus range will be set to a default value of 200 um. j @
Change this to the recommended Range for each objective magnification according & =
to the following table: e ﬂl i
Magnification | Range (um) | Magnification | Range (um) i | oo
4x 350 40x 45
10x 200 60x 30 |
20x 100 100x 20 -

3. The Max focus time will be set to the default of 15 sec. This can be reduced as Contor positon 000
performance of the autofocus is confirmed. The Max focus time should be at least oo 2
that required for successful autofocus but optimally only a few seconds longer. i Farge: 500y 5100
Autofocus of 3 seconds should be possible in flat labware with 2D samples.

4. Click OK and autofocus will occur. The Focus Z level in Manual XYZ will now be
updated to the new autofocused Z level. The actual time taken to reach autofocus, i.e., the Autofocus
time (sec), will also be shown.

5. If autofocus did not result in a sharp live image, make sure the Center position transferred was correct.
In general, if autofocus consistently uses the full Max focus time, the range is too great for the time
entered or the time is insufficient. It may be necessary to decrease the Focus range and/or increase
the Max focus time.

6. Upon successful autofocus, move to other locations distant from the initial location. Click Select
Labware in Manual XYZ and the appropriate Labware Map will open (see Section Il.E.3. above). Select
a location and repeat Steps 1-4 above.

7. Continue to move to other locations far away from the initial ones and repeat autofocus. It may be
necessary to re-enter the Center position and/or adjust the range. To determine the final parameters,
review the upper and lower Z levels obtained and use the approximate mean for the Center position.
For the range, determine the spread between the highest and lowest Z values and add the suggested
buffer listed in the following table:

Magnification | Buffer (um) | Magnification | Buffer (um)
4x 400 40x 50
10x 200 60x 36
20x 120 100x 24

L. Writing and Using Protocols

17
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1. To configure an automated microscopy run, including time-
lapse on the manual LS620, LS560, and LS460, the Protocol
feature is utilized. Click the “P” icon in the Left Tool Bar.

a. LS720o0nly. Picon is sixth from the top and there are five

tabs.
b. LS620 only. P icon is sixth from the top and there are
three tabs.
c. LS 560 and LS460 only. P icon is fifth from the top and — i e | e

there are three tabs.

2. Information and values will be added on the various tabs. Be sure to click Save before leaving any
Protocol.

3. Inthe first tab named Information, click the Load Existing button to bring up a

Save Protocol File

previously saved Protocol. If the desired Protocol is present, click OK. Click the
Clear Existing button if values have been entered on any of the tabs and saving
is not desired or a previous Protocol is displayed and you want to start a new
one. If unsaved entries are being cleared, a Save Protocol File dialog box will
open asking if you want to save the current Protocol. If Yes, click OK. e

[y TestProtocol epf

Folder: [C\Etaloma\Lumaview720\ProtocolConfigurationFies

4. If not previously saved, enter the new desired Protocol name in the Filename Corce

field and click OK. Or click on an existing File name to overwrite and a File
Overwrite Alert will open; click Yes. You are now ready to create a new Protocol.

5. On the Information tab, if you enter User Notes, they will become part of the new Protocol. You can
also enter User Notes for a previously saved Protocol in this tab.

6. Click on the Acquisition tab to select the acquisition mode:
Single Image, Time-Lapse, Video, or Time-Lapse Video. L5720
has all 4 modes and LS620, LS560 and L5460 have only Time-
Lapse Mode.

a. Single Image mode will snap an image of each location

selected.
b. For Time-Lapse, enter the Interval and Duration e e — | L]
information.

IMPORTANT: Before initiating a time-lapse run, it is critical to change your computer power and
Windows update settings so they cannot automatically turn on and interfere with scheduled image
captures. See Appendix G for details. (After time-lapse is completed, be sure to change the settings
back.)

c. Live Video

d. Video Time-Lapse

18
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10.

Click on the Image tab to select the channels to be used in
the Protocol and adjust their settings. If settings were
previously determined in Manual Image (Section II.E above),
transfer the values into the current Protocol by clicking the
Use Manual Settings button. The desired values can also be
entered manually. Note that this dialog box cannot be used
to optimize the image settings because it is not interactive

with Live Image Window.

RunProtocol | | Siop Prtocol

===

Protocol % complets: |

If optimization of any of the Channel settings has not been done or is still needed, click on the Manual
Image icon on the Left Toolbar (top icon) to open its dialog box and fine tune the settings with a
representative sample (Section II.E above). When settings are satisfactory, click the Use Manual

Settings button in the Image tab to upload them into the Protocol.

LS720 only. Click the fourth tab XY Z to define the locations in

the labware to be imaged. Click Enable Stage to adjust the
settings. Click the Select Labware button to choose a labware
type. Locations can be selected by clicking on them
individually or clicking on the name of any row (A, B, etc) or
column (1, 2, etc).

LS720 only. Images can be saved to individual folders for each

e

Frotocol % complete: || | Seve Efy

location. Check “Save to folders named for wells”. If you prefer images to go to one folder, uncheck
the box. In Instrument Setup you may also choose the setting that saves images according to channel

(Section 11.D.).

LS720 only. Click on the Focus Settings button to open its dialog
box. There are 4 options to set up focus in a Protocol:

a. Manual Focus. Uncheck both Use Auto-Focus and Use Z-
Map. Under Manual Focus Control, click the up and down
arrows to determine the desired focus level. This will be the
focus level for all locations in the Protocol.

b. Autofocus. Check Use Auto-Focus and uncheck Use Z-Map.
Under Autofocus Parameters, click on Use Manual Settings to

Focus Settings

Z-axis position: [38830  ym

¥ Use Auto-Focus

Manual Foous Control

I Brightfield [ Green

I Bue ¥ Red

Z:Map File Selection

E e e =

load focus settings previously determined in Autofocus Setup launched from Manual XYZ (Section
II.).). To use the manually determined focus position in this dialog box (Z-axis position in the upper
left), enter the Z-axis position into the Center position. Also enter the desired Focus range (um)
and Max focus time (sec). To test autofocus in other locations, click the Manual XYZ icon (second
from top) in the Left Toolbar and follow the steps described in Section I1.K.

c. Z-Map. Uncheck Use Auto-Focus and check Use Z-Map. Follow steps described below in Section
Il.L. below to create a Z-Map for each location to be imaged in the Protocol. To use an existing Z-

Map, select the file under Z-Map File Selection.

LS Microscope Startup Manual 2018.7.25
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d. Autofocus plus Z-Map. Check both Use Auto-Focus and Use Z-Map. Set Autofocus Parameters as
described above in Step b, this Section. Follow steps described below in Section Il.L. to create a Z-
Map for each location to be imaged in Protocol. To use an existing Z-Map, select the file under Z-
Map File Selection.

e. Under Select Focusing LED Channel(s), check the channels desired for autofocusing. Currently,
channels are acquired in a fixed sequence of BF, Blue, Green, Red. Any selected autofocus will also
occur in this sequence. If using autofocus, you must select the first LED channel to be imaged as
an autofocusing channel per the listed order above. The subsequent channels in your protocol
channel sequence are optional for autofocusing. If the subsequent channels are not chosen, the
focus will stay at the level determined for the first channel in the sequence. For example, if you
are snapping brightfield and red channel images, select at least the brightfield channel for focus.
Autofocus will occur in the brightfield channel and then remain at that level to capture the red
channel image. If you want the red channel to also be focusing, select both the brightfield and red
channels.

M. Creating a Z-Map

Manual XYZ [
1. Load desired labware with samples into labware carrier. ; S ]
S—
. . . . . . . o A
2. Find a Live Image in a location as described in Section ILE. | *** — «[» .
above. L
e
Z: |3277.998 ﬂ ie;;: El: ’S:;é:‘?:ss:ﬁﬁ%‘v;m‘;;jm
3. Set up Autofocus using steps in Section Il.J. above. . et cme =15,
JA w3
Fiiios: Num. Z slices:
4. In Manual XYZ, click the Create Z-Map button near the L L]
bottom. The Select Labware dialog box will open. Click 5, Tl e
on the labware type desired to highlight it and then click T
OK.
s
. . . . . . %ﬁump
5. A Z-Mapping instruction dialog box will now open. Click
Ye S. Choose Name for the Z-Map File o
Folder: [C:\Etaluma\Lumaview720\ZMap Files ok |
o . . AARRA TS IDDEEEER
6. The Choose Name for the Z-Map File dialog box will oo e
now open. Choose the Filename for your Z-Map file
and click OK. P
7. The Z-Map Selection dialog box will now open. Select

the locations in the labware to be Z-Mapped. Locations can be selected by clicking on them individually,
clicking on the name of any row (A, B, etc) or column (1, 2, etc), or clicking on Select All.

8. Click OK and Z-Mapping will begin.

N. Editing a Z-Map

20
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1. In Manual XYZ, click the Edit Z-Map button at the bottom to

EGit Z-Map.

open its dialog box. Select the Z-Map File to be edited.

2. Locations that were Z-Mapped become shaded in yellow.

e Edit ZMap Well 7 X

Click on any Z-Mapped location and the Edit Z-Map Well ARRRRmE

I
[FEOEEEaam

DOEeaE0]
BEEE|

dialog box for that location will open. Click the up and down Sl

arrows to manually change the focus. This allows both

[BEOE S REE)
I OEEEEEEEeEEE
L1

Well: b1
Original z-Auis Position: 9.319945

z um

um%

2step

um):
00 =

oK Cancel

:

review of the Z-Map value and making a change if desired.

Click OK to return to Edit Z-Map. Click Cancel to keep the Z-Map value as it was before.

3. Click on other locations to check and/or change their Z-map values. Be sure to click OK to save any

changes before leaving Edit Z-Map.

B

O. Tiling Across Locations

1. Tiling can carried out as part of a Protocol and set up in the
Protocol XYZ tab. First ensure that the One Tile Per Well is not
checked. Click the Tile Selection button to open its dialog box. A
representative Location will be shown.

Funfrosed | S pooes

Protocol % complete: | ED Eir

2. Select the number of tiles desired using the drop-down menu. The tile grid will then
appear superimposed over the location based on the objective to be used and the

location dimensions. Select the tiles to be imaged by clicking each individually or Select

all. The tile number and tiles selected will apply to all locations to be imaged in the

Protocol. Click OK.

3. Autofocus will be carried out in all selected tiles.

P. Run Protocol

1. After entering all information and saving the Protocol, it is ready to
be run.

2. LS720only. The fifth tab is “Data Review” and will present the
images as they are captured. Channels, including multiples if a
Composite, can be selected as well as the Sequence number of a
Time-Lapse. This allows the monitoring of images as they are
collected in the Protocol. Click on any location to enlarge the
image. Clicking on a tile will also enlarge that tile.

i

Lenriont | | Soorobca | HERREEE

R

3. Data Review images are thumbnails and saved at low resolution. To save the Data Review

configuration of images, use the PrintScreen function.
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WARNING: You must remove red shipping lock before
plugging the LS720 into power! If not removed, the
LS720 will be damaged!

1.

Red Shipping Lock Installation

Appendix A

Red Shipping Lock for LS720

Fig 1 shows how the LS720 arrives with the red shipping lock
installed. Using the supplied 3 mm hex wrench, loosen the
2 set screws on the top of the installed shipping lock (Fig 2). :
Loosen the 2 set screws (smaller and more internal) on the Fig 1. Shipping lock installed
bottom of the lock (Fig 3). on LS720

Fig 2. Installed shipping
lock from top showing 2
set screws

Unscrew the 2 larger screws on the bottom of the shipping lock (Fig 3) completely. Slide
the shipping lock toward you to remove.

Keep the 4 set screws screwed into the shipping lock and place in a secure place along with |

the 2 loose 1-inch screws and 3 mm hex wrench. ) o
Fig 3. Installed shipping lock

from bottom showing 2 set
screws (smaller heads) and 2
1-inch screws (larger heads)

WARNING: You must install red shipping lock before placing the LS720
into shipping carton! If not installed, the LS720 can be damaged!

1.

The red shipping lock comes with 4 nylon-tipped set screws inserted from the outside so

tips face each other (Fig 4). If screws were removed previously, insert them. Adjust so

each set screw tip is flush with the inside metal surface (screw heads will extend on the

outside). There should be two 1-inch screws. >
v <

In Lumaview, open Manual XYZ, and set Z to 0. Set step size to 10 mm, and move plate

carrier toward front until end of travel. If carrier overhangs the deck, change step size to

0.5 mm and move back until there is no overhang. Repeat for side positioning by setting  Fig 4. Shipping lock with

step size of 10 mm and moving carrier to left until end of travel. Change step size to 5.5 screws & wrench

mm and press left arrow one time to move carrier slightly right.

Slide shipping lock into position at front of deck just left of the Deck Knob (Fig 1) so the 2 holes in the shipping lock
line up with 2 holes on the front underside of the deck. Screw in the two 1-inch screws (Fig 3) until tight using the
supplied 3 mm hex wrench (official torque is 16 inch-pounds).

Tighten the 4 set screws in the shipping lock with the 3 mm hex wrench until just tight with labware carrier (top 2
screws, Fig 2) and deck surface (bottom 2 screws, Fig 3). Do NOT over tighten. Set screw heads will be approxi-
mately even with shipping lock surface.

Test by trying to lift labware carrier at front where it is being held by shipping lock. If labware carrier can be lifted
at front, tighten the two 1-inch screws and then the 4 set screws a little more until labware carrier is securely
locked. (Labware carrier may still be movable a small amount in areas where shipping lock is not located.)



Appendix B

Uninstalling a Different Version of Lumaview

Go to Control Panel/Programs & Features, right click on the Lumaview file, and select Uninstall. After uninstall is
completed, verify that the Lumaview folder is now gone from the C:/Program Files (x86)/Etaluma folder. You are
now ready to install the new version of Lumaview.



Appendix C

Disinfecting the LS Microscope Before Placement into an Incubator
Before placing the LS Microscope into an incubator, use one or several of the following procedures.
Wipe with Alcohol

Use ethanol or isopropanol diluted to 60-90% (typically 70%) with water for standard biocidal activity (do not use
100%). Alcohols are effective against lipid-containing viruses and a broad spectrum of bacterial species, but are in-
effective against spore-forming bacteria.

Wipe with Bleach

Use household bleach (sodium hypochlorite) diluted to 10% with water for a broad spectrum of antimicrobial activity.
Because of its oxidizing power, bleach loses potency quickly and should be made fresh and used within the same day.
Allow to remain in contact for 10 min. Bleach is corrosive to stainless steel and must be wiped away using sterile wa-
ter.

Exposure to Hydrogen Peroxide Vapor (HPV)
If the incubator to be used has on board HPV disinfection cycles, it can be used to destroy biological agents. Follow the

incubator’s recommended conditions, e.g., a seven minute HPV fog with circulation by the incubator airflow blower
followed narrow-bandwidth UV light. LS Microscopes have been found to withstand repeated (>10) cycles of HPV.



Appendix D
Resolving Lumaview Driver Conflicts

Occasionally conflicts can occur between the drivers used by Lumaview and other Windows drivers, preventing com-
munication between the LS Microscope and the connected computer. Follow the steps below. It may also be neces-
sary if the computer USB port used for connection to the LS Microscope is changed and/or the computer undergoes a
Windows update.

A. Detecting a Driver Conflict

1. One of the following messages in the upper left corner of Lumaview is observed (Figs 1 & 2).

e USE device unplugged or resetting M Lumaiew 620 V15.11.60

File Configuration Utilibbes Windows Help File Configuration Utilities Windows Help

Fig 1. No Live Image Window and phrase “USB Fig 2. No Live Image Window and Lumaview
device unplugged or resetting” is shown. version number is shown.

B. Removing the Driver Conflict

1. First log on as administrator on your computer. Go to C:/Program Files (x86)/Etaluma/Lumaview 720. In the
Lumaview 720 folder, right click on driver_uninstallation_helper and in the pop-up menu, click Run as adminis-
trator. (Note: If your computer is set up differently, you may need to inquire as to how to run as administra-
tor.) The User Account Control dialog box will come up, click Yes, and the Device Manager will open.

2. With the computer connected to the LS Microscope, in Device Manager click the View tab. In the pull-down
menu, click Show hidden devices. Verify that libusbK Usb Devices is present in the list.

3. If libusbK Usb Devices is not present in the list, you will need to reinstall the current version of Lumaview.
From the download location on your computer (e.g., in the Downloads folder), double click the Lumaview_v....
file to start the install. The Lumaview Setup Wizard dialog box will open; select Repair Lumaview720 and click
Finish. The installation will proceed, including the opening twice of the Device Driver Installation Wizard
(click Continue each time) and then finish.

4. Disconnect and then reconnect the USB cable from the computer to the LS Microscope. Repeat Step 3 above
to verify libusbK Usb Devices is now present.

5. Inthe same Device Manager dialog box, scroll to the bottom of the device list and click on Universal Serial
Bus controllers to expand the list. Look at the top of the list
for specific controller names (not the nonspecific such as USB
Root Hub or Standard OpenHCD Host Controller). Examples of
conflicting drivers identified thus far that might be there in-
clude:

BodeVib
Holdtescs
Cypress
NDTech

Fig 3. Conflicting driver BodeVib Vibra-
tion Data Processing System.



6. It may be necessary to unplug the LS Microscope (via the USB cable) from the computer and look for any
names in the list where the name font color has turned a lighter gray. Reconnect the LS Microscope and verify
that the one that turned lighter gray is now darker gray again. This is the driver that conflicts with the LS Mi-

croscope drivers.

7. Right click on the conflicting driver, in this example BodeVib Vibra-

tion Data Processing System, Fig 3, and in the pop-up menu, click on

Update Driver Software... as shown in Fig 4.

8. Inthe next dialog box that appears, click on Browse my computer for

driver software as shown in Fig 5.

9. Inthe next dialog box that appears, select Let me pick from a list of
device drivers on my computer as shown in Fig 6.

10. The next dialog box that appears will show the choices for the hard-
ware devices (Fig 7). The Show compatible hardware box should be
checked. Select 600-Series Lumascope and click Next. Windows

should now install the LS Microscope driver over the conflicting driv-

er.

11.
computer and then reconnect it.

When installation is complete, disconnect the LS Microscope from the
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Fig 5. Selecting Browse my computer...

S

BedeVib Vibration Data Processing System
Browse for driver software on your computer

Search for driver software in this location

[C:\Usens'\Corbun' Documents) Browie

[ include subtolder

Fig. 6. Dialog box showing option
to select Let me pick from a list...

Select the devi you want to install for th

nd model of your hardware device and then chick Next. If you have a

er you want to install, click

Select the mans

P sk that contas

2] Show comptible hardware

Model

2 BodeVib Vibration Deta Processing System

This driver has an Authenticodeftm) sianature, Have Disk...

. 7. Selecting the 600-Series Lumascope.

These steps will need to be performed on every USB port that will be used with the LS Microscope.

NOTE: Older versions of Windows may ask you to restart your computer before the driver becomes functional.



Appendix E

Lumaview Folder File Organization

1 = | Lumaview720 - o
o T
&« v > ThisPC > 0S(C) > etaluma > Lumaview720 vy Search Lu
~ -~
# Quick access Name
& Downloads * CalibrationFiles
I Desktop B LabwareFiles
| Documents * LogFiles
" ObjectiveFiles
& Pictures -
On-Demand
T20screens PixelMapFiles
BestStuff ProtocolConfigurationFiles
images ProtocolimageData
Meeting Agendas ZMapfFiles
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Appendix F

Capturing and Compiling Live Video Using AviSynth and MeGUI

. ltis first necessary to download and install the following two freeware programs.

a. AviSynth video post-production program found on the AviSynth Wiki at http://avisynth.nl/index.php/Main_Page. Down-
load and install the Official Build. The default save location for the program will be the Etaluma folder inside the Program
Files (x86) folder.

b. MeGUI video conversion program found at http://sourceforge.net/projects/megui/. After the zipped folder
(MeGUI_2525 x86.zip) has downloaded, click to open and Extract All. Depending on your computer and Windows ver-
sion, it may be necessary to right click on the .zip file to complete the extraction. After extracting the files from the zipped
folder, you will see the file MeGUI Application with a green icon in the MeGui_2525 x86 folder. Extraction so that the
green icon is shown is essential for the images to be scripted correctly for video compiling. If desired, make a shortcut on
your desktop.

Video Configuration U -

When the desired field has been illuminated and focused in Live Image Window
(Section Il. above), click the Video Record icon in the Left Tool Bar (fifth from the top) to
open its dialog box. Also check parameters such as format type in Instrument Setup
(Section 11.D.) Enter the Full Path information and check Add time-stamp label if de-
sired. Images captured will be saved to the folder shown; this can be changed, e.g., to a

artal irtager rumbers of esch image fie saved

300 yyyyMMG3_HiHmmaes\My Expanmert oooooctf

new subfolder set up within the Video folder.
Click OK and image capture will begin. To stop image capture, click the Record Video icon in the Left Tool Bar again.
To compile the images into a video, click on the MeGUI Application to open the program (may take several minutes).

“w n

At the end of the AviSynth Script line near the top, click browse (“...”). A MeGUI window named Open AviSynth script will
open. Depending on the computer and Windows version used, the channel subfolders from the most recent time-lapse cap-
ture (F1, F2, F3, W) may be listed. Or it may be necessary to browse to your Destination Folder and open to access the channel
subfolders. Open the desired subfolder and click on the Avisynth (.avs) file.

A preview video window will open; click Play to see a short segment of your video.

Return to the MeGUI window and select File Format (MP4 recommended). Click Queue button for Video encoding on right
(button about halfway down the dialog box).

An encoding window will open and you will see progress in a green horizontal bar until video is completed and window closes.
Close MeGUI window.

Video will be saved in the channel subfolder within the Destination Folder chosen above.



Appendix

Setting up Windows 10 for Uninterrupted Time-Lapse

A. Power Settings

Navigate to Settings (click on the Windows icon on the lower left of your screen
and then the gear icon). Choose System, then Power & Sleep in the left column.
Choose “Never” for all items. Make sure your computer is plugged in for the
duration of the experiment.

Click on Additional power settings and Change plan settings next to active plan.
Click on Change advanced power settings. Scroll to “Hard Disk” and click on the
“+” keys to open the selection. Click on blue writing and change the time to
“Never”. Scroll to “Sleep” and expand the selections. Make sure every item is
selected as “Never” or “disabled”. Under “USB Settings”, open “USB Selective
suspend setting” and make sure it is set to “disabled”. Press Apply to save, then
OK.

B. Connection Settings e

@ Home

Network connection NOT required:

& Status

Disconnect the Ethernet cable (if wired connection is used) and turn on

2 Ethemet

Airplane Mode. Navigate to Settings -> Network & Internet -> Airplane . ...,
Mode (left side) -> ON. Or click on the Wi-Fi icon on your Tool bar and o
click the Airplane Mode button. Airplane Mode will prevent all wireless

3P Power Options ? *

Advanced settings

\<@ Selectthe power plan that you want to customize, and
; then choose settings that reflect how you want your
computer to manage power.

My Custom Plan 1 [Active] M

Turn off hard disk after A
:
Plugged in: Never
% Internet Explorer
7 Desktop background settings
% Wireless Adapter Settings
Sleep
Sleep after
On battery: Never
Plugged in: Never

Alloss, bushrid claan.

[ ok ]| Conce

Airplane mode

0 Turn this on 1o stop all wieless communication, such as Wi,
L and Bivetooth

Bl

@ on

Wireless devices
s
@ o

Bluetooth

@ on

4 Mobile hotspot

communications (Wi-Fi, Bluetooth and cellular) between the computer — @cee

and other devices.

Note: You may also click on the Wi-Fi icon on your tool bar, then click on the Air-

plane Mode button.

Network connection required:

Navigate to Settings -> Network & Internet -> Wi-Fi. Click on Manage known net-
works, then select your network and set the following:

“Make this PC discoverable” — OFF
“Metered connection” — ON

If you set your network as metered, Windows will not download updates. Reset to
OFF after your experiment to receive updates.

Connect automatically when in range

@ on

Make this PC discoverable

Allow your PC to be discoverable by other PCs and devices on this
network. We recommend turning this on for private networks at
home or work, but turning it off for public networks to help keep
your stuff safe.

@D off

Metered connection

If you have a limited data plan and want more control over data
usage, make this connection a metered network. Some apps might
work differently to reduce data usage when you're connected to
this network.

Set as metered connection

@ on



